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Information overload is real. You don't always have time to read a 5,000-word feature or juicy interview when it pops up on your Twitter feed. And even when you do have the time, you may be underground between subway stops, caught in a dead zone, or have no Wi-Fi connection. The most reliable way to catch up on your digital reading is to make
sure it's saved and accessible for offline reading. Many apps and browsers can help you save it for later. Here's how to download what you want and keep it readable, even without an internet connection.Save a Web Page in Chrome DesktopFor Chrome users on the desktop, the easiest built-in way to save a web page for offline reading is to download
the page as a file. Open the three-dot menu on the top right and select More Tools > Save page as. You can also right-click anywhere on the page and select Save as or use the keyboard shortcut Ctrl + S in Windows or Command + S in macOS.Chrome can save the complete web page, including text and media assets, or just the HTML text. Download
the file you prefer to your computer and read the page at any time, even without an internet connection.Android Save a web page on the Android app by opening the three-dot menu icon and tapping the download icon up top. A banner at the bottom of the screen will tell you when the page has been made available for offline reading. Click Open to
view a static version of the page. Access downloads later by opening the three-dot menu and tapping Downloads.Chrome on iOS and iPadOS To make an article available for offline reading within the Chrome app on iPhone or iPad, tap the Share icon (an upward-facing arrow) and select Add to Reading List. Open the browser's three-dot menu and
select Reading List to view any saved pages. Long-press a saved item until a menu pops up, then tap Open Offline Version and you're ready to read offline.Save a Web Page in Microsoft Edge Microsoft's Edge browser is powered by the same Chromium engine found in Google Chrome, so directions here will be similar. Click the three-dot ellipsis menu
on the top right and select More tools > Save page as to download a file to your PC.On Android, the process is also similar to Chrome, but the three-dot menu is in the bottom-center of the screen. Tap it, swipe up slightly, and select Download page. The download will appear at the bottom of the screen; tap Open to read. To read later, tap the threedot menu and select Downloads. Web pages you have saved will be available to read offline automatically. On Edge for iOS, the Reading list option appears when you tap the three-dot menu, though it was grayed out for us. Your best bet might be to tap the Share icon and Save to Pocket.Save a Web Page in Safari Save a web page in Safari by opening
File > Save As. You can then pick between file formats Web Archive (all text and media assets) or Page Source (source text only). Choose File > Export as PDF if you need a PDF version of the article. Safari also has a Reading List feature that allows you to save articles for offline reading. Desktop users can click the Share icon and choose Add to
Reading List. Another option is Bookmarks > Add to Reading List. Once added, click the Show sidebar button in the Safari toolbar and make sure the eyeglasses icon is selected. Right-click an entry and select Save Offline.Make sure saved articles are available for offline reading by default under Safari > Preferences > Advanced. Check the box next
to Save articles for offline reading automatically.The process works similarly on iOS and iPadOS. Tap the Share pane and choose Add to Reading List. Tap the Bookmark icon and choose the eyeglasses icon to view your reading list. Long-press the article and select Save Offline from the pop-up menu to save the article. Set saved articles to be made
available offline by default under Settings > Safari. Scroll all the way to the bottom and turn on the switch next to Automatically Save Offline.Save a Web Page in Firefox For offline reading with Firefox, open the hamburger menu and choose Save Page As to download the page as a file. You will have the choice to download the complete page, the
HTML only, or a simple text file. Otherwise, the desktop browser relies heavily on integration with Pocket, the save-it-later service Firefox maker Mozilla acquired in 2017. Right-click and select Save Page to Pocket to do just that, or click the Pocket icon on the top right. Content saved to Pocket is accessible via GetPocket.com(Opens in a new
window) or the Pocket mobile apps. Refresh Pocket to make sure what you saved appears in your account, and it will then be available to read offline. The iOS version of Firefox has a reading list feature that allows for offline reading. Open the three-dot menu in the search bar and select Add to Reading List. Once an article has been saved, tap the
hamburger menu and select Reading List. Select the article you want to open and it will be made available to you offline automatically.On the iOS and Android Firefox apps, meanwhile, you can select Save to Pocket, too.Extensions and Apps Though save-it-later service Pocket is owned by Mozilla, it's not limited to Firefox. It's available as an official
browser extension for Chrome(Opens in a new window) and Safari(Opens in a new window) for one-click saves, and on mobile(Opens in a new window).Other options include the Save Page WE extension for Chrome(Opens in a new window) and Firefox(Opens in a new window), which saves web pages to your computer with a single click; adjust the
settings to determine how much information is saved.For more high-powered solutions, turn to the utility software HTTrack(Opens in a new window) (for Windows, Linux, and Android) or SiteSucker(Opens in a new window) (for macOS and iOS). These programs can download entire website directories from a URL, letting you navigate a site while
offline. Sign up for Tips & Tricks newsletter for expert advice to get the most out of your technology. This newsletter may contain advertising, deals, or affiliate links. Subscribing to a newsletter indicates your consent to our Terms of Use and Privacy Policy. You may unsubscribe from the newsletters at any time. Something went wrong. Wait a
moment and try again. Internet might be a blessing, but like every other blessing, it’s not available to everyone or all the time. There are many places where there’s no WiFi or internet connection. But, what if you want to access a certain website in a no-internet zone? Well, don’t fret my friend, as they’re a lot of ways you can access your favorite
websites offline. Below I have listed some ways you can download and browse web pages offline on any of your devices. Whether you want to download a single web page or an entire website, the following write up will guide you through the process. So, let’s dig right into it. 5 Apps to Access Websites Offline 1. Download specific web pages If you just
want to download specific web pages for viewing later, your browser can easily do it for you. It can download the whole page with all its components and let you browse it offline in the browser again. On PCs On Windows, Mac, and Linux, simply press Ctrl + S keys on your keyboard, while using any browser, to bring up the “Save page” dialog and
simply save the page in your preferred directory. An HTML file and a folder containing all the data will be saved. You can open the HTML file to access the saved web page in your browser without requiring any internet connection. On smartphones Reading a website offline is an option that comes with both Chrome for Android as well as the iOS
Chrome mobile app. In the Chrome for Android, open the page that you want to save for offline viewing and tap on the main menu button at the top-right corner. Here tap on the “Download” icon and the page will be downloaded to your device. You can open it to view the web page in your default browser. In Chrome for iOS, the Reading List feature
lets you save web pages that can be read at a later time. For that, you need to go to the Share Sheet menu and tap on the “Read Later” option. All articles that are saved can be easily accessed via the Reading List option found in Chrome’s “Settings” Menu. iOS users can also use Safari’s Reading List feature to save web page content for viewing later
and also sync it to other devices. 2. Enable offline mode in Chrome & Firefox Chrome and Firefox come with an Offline mode that’ll let you load a page from browser cache in case you don’t have internet connectivity. When you enable this mode, the browser will give you the option to load web pages from the cache. So you can basically access any
web page offline that you have accessed before. Note: Do not clear internet cache if you want to keep the cached web pages for offline use. Enable offline mode in Chrome In Chrome, type chrome://flags and look for a flag named “Show Saved Copy Button”. Click on the drop-down menu below it and select “Enable: Primary”. Now restart the browser
to let the changes take effect. Whenever you will visit a page offline that you have visited before, you will see “Show saved copy” button. Click on it to load the web page offline. I will also recommend you to bookmark the important web pages for easy access. Enable offline mode in Firefox In Firefox, click on the hamburger menu at the top-right
corner and then click on the “Developer” option here. A list will show up through which click on the “Work Offline” option to enable it. Now even if you do have the internet connection, Firefox will be offline and you’ll only be able to access the websites that are already in cache. 3. Use HTTracks (for Windows, Linux and Android) HTTracks is a
popular tool to download the whole data of a website and access it offline. It is an open-source tool that is available for Windows, Linux and Android platforms. It will download the whole website by moving from link to link, so it is also able to format the archive like you are browsing the website online. Although HTTracks is highly customizable, but it
has a simple wizard to let novice users easily download website data. Here’s how to use it: Install and launch HTTracks and click on the “Next” button to start the wizard. You will be asked to provide name for the project that you want create. This name will help you identify the data when you want to access it later, so make sure it’s relevant. On the
next page, click on the “Add URL” button and enter the URL of the website that you want to download. You can also add multiple websites, if you want to download the data of more than one website. There is also a“Set options” button where you can find some really handy customization options. However, you should first read HTTracks manual
before messing around with the options. Now simply click “Next” and then “Finish” to start downloading the website data. The process could take a lot of time depending on how big the website is. It may even take days to download a website as massive as Hongkiat.com. On top of that, this data could easily take GBs of space on your hard drive, so
make sure you have enough space. Once downloaded, you can open the project to start browsing the website in your default browser. Tip: HTTracks starts downloading data from the latest updates and moves backward. If you only want latest data and not the whole website, then cancel the download process when you are sure that the needed data is
downloaded. Even if the download process is cancelled, you can still access the data that has been already downloaded. 4. Use SiteSucker (for macOS and iOS) SiteSucker is a great alternative to HTTracks for macOS and iOS users. It works similar to HTTracks and downloads websites as a whole by jumping from link to link. You can also pause
downloads in the middle to view the downloaded web pages and resume any time you like. 5. Browser extensions to read websites offline There are some browser extensions with which you can download website data and view it offline. Below are some extensions for Chrome and Firefox that you may like: Page Saver (for Chrome) PageArchiver lets
you save multiple web pages and access them from its interface. You can download all the web pages that are currently opened in your browser. Simply open the pages you need and download them with PageArchiver. WebScrapBook (for Firefox) WebScrapBook lets you download a single web page or a whole website. It also organizes the
downloaded content in its interface and a handy search bar makes it easy to search for the right content. 6. Use Pocket to read article offline If you only want to download online articles to read later, then Pocket might be a great option. It has compatible extensions for all the popular browsers that you can use to save articles and other supported
content. The articles will be first decluttered from all the junk such as ads, recommendations and widgets, etc. and then are saved in Pocket cloud storage. After that, all the articles will be synced over all your devices with pocket installed and made available for offline viewing. Round Up For saving single web pages, the built-in save feature of the
browser is more than enough. Although a good extension can definitely make things cleaner if you need to save web pages often. And of course, for downloading the whole websites, HTTracks and SiteSicker are the best options. If you know any other tools to save websites for offline viewing, do share with us in the comments below. Two New Ways to
Download Websites for Offline Viewing in Chrome for Android
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